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We are going to be talking about animating objects in DAZ Studio. First off we'll
talk about the Timeline and all its controls. Then we'll go over animating a single
object using this Timeline. Next we'll go over multiple objects being animated and
interacting in a scene. Lastly, we'll advance into animating an actual figure.

This guide was developed using DAZ Studio v4.6.3.50 Pro and tested using DS 4.7
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There are multiple layouts that you can use in DAZ Studio. To find them and
change your settings, go to Window->Workspace->Select Layout.

: . & Cameras Render

A& customize...

This tutorial will be using the 'Hollywood Blvd' layout. Choosing the same layout
setting will make it much easier to follow along.

Full Service [Beta]

Layout :

Bctors, Wariobe 8 Props Past bt Ughta & Comeren  Mari

Description :

dream of having your name in lightz, eh? Then no more Full Service for
itz time to take a peek behind the curtain and start understanding how things |
actually work. This layout uses ¢ terms associated with movie-making to
help beginning users make a connection between something very new [and
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In DAZ Studio, there are multiple styles that you can use. To find them and
change your settings, go to Window->Style->Select Style.

Toolz= Render Connect Window Help

Panes (Tabs)

Actors, Wardrobe & Props F : & Cameras

Select an Hem... | ¥ re Lights Ctri+L

In the style window that will popup, select the 'Main Street' style, then hit
'Accept’ in order to use the same style that we use in this tutorial.

Style : g in

File Edit Create Tools Render Connect Window Help Internal

Poser Formats » E‘ My DAZ Library
" Other Import Formats
Ei Products
ﬁ Categories

Version : 462113

Description :

This style is big and bold. It is comprised of neutral gray tones and a sharply contrasted yellow highlight
that is intended to draw your attention... a bit like painted markings guiding you along the road to
SUCCESS.
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To get started animating, find the Pose & Animate tab at the top of DAZ Studio.

File Edit Create Toole Hender Connect Window Help

Actors, Wardrobe & Props Pose & Animate Lights & Cameras Render

LA

You'll notice once you do this, there will be a bottom window that appears. Make
sure that the Timeline tab is selected as this is where we'll be starting. If the
animation timeline is not visible, click the small upwards pointing arrow tip.

File Edt Create Tools Rend indow Help

Actors, Wardrobe & Props Pose & Animate Lights & Cameras Render )-V4 J\'.‘BD Home:

]
.|

[Entertestto fiter by

What do | do? w R B Defaur Camera

1. ke sure you are using the
“Universal” tool. Main Menus:
Tools > Universal

Parameters

2. Selectand object or part of
an object (like a hand) in your

3. Drag your selection around
inthe scene or use the
universal teal to move and
rotate it. Or, selecta property

group from the list at the left
then adjust the property
controls

Content Library

<_>o| Settings

aniMate Lite Timeline E
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The Timeline is where you'll be spending a lot of your time during animation.
Learning how to use it is a simple, but essential part of animating in DAZ Studio.

aniMate Lite Timeline ’E
15 25 30

There are two views to our Timeline. We have the Basic View which you'll see
now. This view gives us minimal information that we'll need, mostly just the
basics for watching our animation. Then there is the Advanced View. To get to
this view just Right-Click on the Timeline tab, and select Advanced View. If
your Timeline starts on Advanced View, you can skip this step.

aniMate Lite Timeline

Play All Frames.
Wake Pane Undockable
Make Pane Group Undockable

Close Pane

These are the control buttons for the Timeline which allow you to adjust the
playhead and add/delete keyframes. We'll cover these in detail shortly.

11
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In the Advanced View, the time measuring gauge actually consists of two number
lines with the bottom being the actual Timeline and the top being a Range for the
Timeline.

On the bottom left, the advanced view displays the Total amount of frames in the
Timeline as well as the current Range of frames used.

And finally it gives us information on the current frame you are on (viewing) and
the FPS (frames per second) speed of the Timeline. The higher the value of FPS,
the faster the animation plays, since it has to fit more frames in each second. The
default speed is 30 FPS.

12
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Frames

Frames are single instances (renders) of an animation at a given point in time.
Initially the current Frame starts on 0 with the current frame being indicated by
the Orange triangle on the Timeline.

The current frame can also be seen next to the label 'Current:' in Advanced View.

13
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Let's say we have an animation of a Sphere dropping down to the ground in five
frames starting on Frame 0 and ending on Frame 5. If we look at the viewport,
we can see that our Sphere at Frame 0 is at the very top of its animation.

.-.. Default Camera v .J' [

14



www.WINTERBROSE.com

You can left-click on the Timeline to change the current frame. I changed the
current frame to the end of the animation which is located at Frame 5.

At Frame 5, the last frame of our animation, you can see that the Sphere is now at
the very bottom of it's animation.

8« Default Camera

*
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Range

Range indicates the range of our Timeline. Currently the Range is 0 to 30
meaning we can see Frame 0 up to Frame 30 on our Timeline, a total of 31
Frames (as shown in the "Total:' field).

NOTE: When the Range minimum and maximum
pointers are located on the number line just
below a hash mark representing the 5-count of
frames, they may appear to be a downward
pointing arrow but are not.

To change the Range you can left-click and drag the tiny downward pointing white
triangle. There are two of them, one on the left-side and one on the right side of
the Range number line. I moved the left (lower) range to the value of 2. Now the
lowest Frame we can view on our Timeline is Frame 2.

Total: Range:

16
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You can also change the upper range by dragging the downward pointing white
triangle found on the right side of the Range number line. I changed the upper
range to a value of 28.

Now the Range is Frame 2 to Frame 28. These values can be typed into the
textboxes instead of using the Range number line. Notice however that even
though we changed the Range, we still have a total of 31 Frames. They are still
there, but as of now the Timeline only cares about the Frames within the current

Range.

17



www.WINTERBROSE.com

Keyframes are the meat of the Timeline. As assumed by their names, keyframes
indicate the important or “key” frames in the Timeline. Keyframes are denoted by
black upward-pointing triangles on the Timeline.

Let's go back to the first animation example with the Sphere. You can see the 2
keyframes in the Timeline at Frame 0 and Frame 5. These 2 keyframes make up
the entire animation for the Sphere.

We're now ready to start talking about the Timeline controls.

w0 M > M Ow M Ow Ow

t

18
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Since we just finished talking about keyframes, let's get right into the Keyframe
Controls. Each keyframe control is easy to recognize because they are shaped like
keys.

The Create Keys control with a “plus” sign creates a keyframe at the Current
Frame. If our current frame is on Frame 1, we can click the Create Key control to
place a keyframe at the Frame 1 position.

Create a Keyframe at the Current Time

If instead we want to delete a keyframe at the Current Frame, we use the Delete
Keys control with the “x” sign in it. We can then click the Delete Keys control to
delete the keyframe on Frame 1, removing the keyframe we just created.

19
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The Previous Keyframe control sets the Current Frame to the first keyframe it
finds behind the frame you are currently on in the timeline.

The Next Keyframe control sets the Current Frame to the first keyframe it finds
after the current frame you are on.

Skip to Next Keyframe

If we clicked the Next Keyframe control, it will jump to Frame 3 again.

20
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The playhead is the frame where the animation will start playing when you hit the
Play button. The playhead is essentially the same as the Current Frame.

The Skip To Start button changes the current frame to the starting frame of the
visible playrange.

21
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You can use the Next Frame button to move to the frame immediately after the
current frame.

Step to Next Frame

Use the Previous Frame button to move to the frame immediately before the
current frame.

Step to Previous Frame

22
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The Loop button turns on and/or turns off looping of your animation.

When the icon is two straight lined arrows pointing left and right, looping is off.

When the icon is two curved line arrows forming a circular loop, the animation
will continue to loop over and over after you hit Play until you tell it to stop.

23
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Now we're ready to actually get to animating.
Let's start with a New Scene to add a primitive shape to.

On main menu, go to Create->New Primitive...

File Edit Create Toole Render Connect Window

Actor +=. Mew Camera...
"8 New Distant Light...

]
L

Hews Null...

New Group...

Mew Mode Instance...
Mew Node Instances...
New Geometry Shell...
MWew D-Former...

. MNew Push Modifier Weight Node. ..

25
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Select the Cube in the drop-down menu using Size 1 m and Divisions 1.

Origin :

Options ;

Then hit 'Accept' to create the Cube.

Origin :

Options :

——
1

Size .

26
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Now you'll have a new Cube primitive to play with. In the Scene tab, make sure
you select your Cube.

|2

ﬂ.. Default Camera L !}v

NOTE: Changes to the Default Camera are also recorded
in your animation timeline so be sure to
position your view of the scene in the viewport
before starting to mark keyframes and make
changes to the scene.

27
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Now the first thing to remember to do, whenever you plan on animating, is to
create your base keyframe. This keyframe is your initial starting point for the
animation. If your timeline is not already there, go to Frame 0.

Then hit the 'Create Keys' icon.

You'll now have an initial keyframe where your Cube will start when animating it.

28



www.WINTERBROSE.com

With our base keyframe set, we can get to animating. Go to Frame 10.

Once on Frame 10, move your cube along the X-Axis a good amount. You can do
this either in the Viewport with the transform handles or in the Parameters tab.

'-'. Default Camera L !}' 2

29
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You'll notice that when you move the Cube, a new keyframe will appear
automatically on the timeline at the current frame.

Now you have an ANIMATION! Not much to it, yes, but nonetheless an
animation. Go ahead and change the Range to 0 to 10. This will allow us to play
the animation we just made without seeing any empty frames.

Total: Range: n

You'll see your Timeline change a bit, showing only Frame 0 to Frame 10.

aniMate Lite

Now Play the animation. Make sure Loop is enabled since it will go by quick.

30
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Notice that although we only made 2 keyframes with 2 locations for our Cube, we
still get a smooth animation. This is because the software takes both keyframes we
created, and fills in the empty frames that are between them in an attempt to create
a fluid animation. Therefore our frames 1 to 9 have been automatically filled with
information for us. YAY! This means less work for us (at least for now).

31
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You can see more specifically if you go to Frame 5, the middle of our animation.

The Cube is located half-way between our Frame 0 and Frame 10 locations.

‘-'4 Default Camera

32
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While we are still on Frame 5, let's alter our animation.

Move the Cube upwards, along the Y-Axis.

'E.. Default Camera

33
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Another keyframe will automatically appear after the movement.

Now when you play the animation, the Cube will still head along the X-Axis, but
it will also move along the Y-Axis, reaching it's peek at Frame 5, making your
Cube hop upwards instead of just slide. To make the Cube come back down,
change the Y-axis value in Frame 10.

34
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Hearing Hniomat

Although you can go through the Timeline and manually delete all your keyframes,
if you have a lot of them it is better to just use Clear Animation. Find the
Parameters tab on the right side of DAZ Studio and right-click on the Parameters
tab. Go to Clear Animation->Clear Selected Item(s)...

‘-.. Default Camera L .J'

Bl cube Enter text to filter

All

Favorites

X Translate

Currently Used
v @ cube

¥ |G| General

Parameters

Memorize

Restore

Content

Clear Figure

Clear Figure Pose

Clear Figure Shape

aniMate Lite Timeline

You'll notice all your keyframes disappear from the Timeline. This will reset the
object back to the default (x =0, y =0, z = 0) position world center in viewport.

35
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Scaling & Rotating

So far we've just been translating our Cube in various directions. Since we already
cleared our animation, let's try Scaling and Rotating our Cube in an animation.

Like before, set your base keyframe at Frame 0.

Now go to Frame 5.

36
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Go ahead and Scale your Cube. I scaled it on the Y-Axis.

Now go to Frame 10.

Then Rotate your Cube; I rotated it along the Z-Axis.

37
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If you move to a frame between 0 and S you'll notice the Cube slowly shrinking.

If you move to a frame between 5 and 10 you'll see the scaled Cube start rotating.

38
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Tte (Camera

One thing to note, if you haven't noticed already, is that the camera is also an
object. If you were to move your camera in the middle of an animation, the
camera would move during the animation like any object you had adjusted.

B8« Default Camera

39
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For instance, let's go to Frame 5.

Then let's rotate our camera

"-'. Default Camera

40
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If we look back at Frame 2, you can see the camera moving from its default
position to the new rotated position.

&« Default Camera v f}v

41
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To select the Camera object, in the Scene tab left-click on Default Camera.

(Enter text to filter by..

iy Ry @ cube

Once you select the Camera, you'll be able to see its Timeline. Then you can
delete any unwanted keyframes. Be careful if you use Clear Animation on the
Camera as it will not go back to its default position, but instead move to the very
center of the scene.

NOTE: Each object will have its own timeline and
keyframes. When you Save a Scene, all of the
animation data is saved for each object.

42
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Now let's create a new animation. Select your Cube, clear the animation from
before or start a new scene and create a new cube primitive cube. Go to Frame 0.

Using the cube control, set your viewport view to Front.

'-'.. Default Camera

44
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Set your base keyframe for the Cube.

Now move to Frame 5.

45
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Move the Cube up along the Y-Axis as shown. Use the Create Keys icon to
create a new keyframe. You must do this even if a new keyframe seems to have
automatically appeared. This ensures that your timeline is synced exactly where
you want and not where an automatic interpretation has calculated.

B8« Default Camera

46
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Then go to Frame 10.

And move the Cube left, along the X-Axis and Create another keyframe.

'-'.. Default Camera !)'

47
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Hard Reyframes

Keyframes aren't always JUST keyframes. If we move to Frame 5, where our
middle keyframe is...

You'll notice that the transforms for the Cube are exactly where I set them at:

Y Translate: 130.84
X Translate: 0.00

‘-.. Default Camera L .,) E
v cube

All

Favorites

Currently Used
¥ & cube

» [G] General

Parameters

]
Mesh Resol... [ X Rotate
» [G] Display

©
=
=
4
ol
[=
o]
ol
[=
o
Q

Z Rotate &0

Show Sub tems

ol Settings

48
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Look at all of these keyframes that I made...

...using the Create Keys button. When I create keyframes like this, they are what I
consider to be Hard Keyframes, as in they won't be altered by the software.

49
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Seft Reyframes

Alternatively, if I made the same animation, but instead of manually pressing the
Create Keys button each time I moved the Cube and just accepted the
automatically generated keyframe, [ would get Soft Keyframes. These keyframes
can be altered by the software. For instance, create the animation again, but for
Frame 5 and Frame 10, don't manually press the Create Keys button. Instead,
take the automatically generated ones.

At Frame 5, in the new animation using Soft Keyframes, we see that the X
Translate actually changed, which shouldn't happen since we don't start moving
along the X-Axis until AFTER Frame 5. The X Translate value is now in the
negatives, closer to the value at Frame 10. With Soft Keyframes, the software
manipulates the keyframes in an attempt to produce a fluid animation. In general,
you will probably want to use Hard Keyframes, but it is up to you to decide that.

”. Default Camera

Favorites
Currently Used
v & cube

v [G] General

[G] Translation
[G] Rotation
[E] Scale
[6] misc
[G] Mesh Resal...
» [G] Display

Parameters

Content Library

| Settings

Show Sub ltems

(Note: Changing the value of a Soft Keyframe will make it a Hard Keyframe)

50
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Glroot T ovements

Let's take a look at our original animation that is using Hard Keyframes. There is
an interesting thing to notice if we look at Frame 3.

In our animation we never moved the Cube in the positive direction along the X-
Axis. However, at Frame 3, the Cube has a positive value for our X Translate.

£, Default Camera
cube

{ O

All

Favorites

-
=4
+*

o}

Currently Used
v @ cube

v [G] General

(it |
+
L Jd

o

Translation
II Rotation

Parameters

[G] misc
[G] Mesh Resol... [ X Rotate
» [G] Display

©
S
=
4
-
[=
@
=
[=
o
Q

ol Settings

Show Sub tems

This occurrence is a Ghost Movement, and it's the software's attempt once again
to make the animation fluid. In the next section, I'll show you how to fix this.
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Parametens

A good way to fix Ghost Movements in your animations, is to create a keyframe
before and after your other keyframes with your desired value. For an example,
let's fix the Ghost Movement in our Cube's animation.

We will place keyframes before and after the keyframe at Frame 5. So let's set our
Current Frame to Frame 4.

‘8« Default Camera

cube

All
Favorites

Currently Used

v & cube
¥ |G| General

Y Translate of 108.36 £

Translation
Rotation

Parameters

X Rotate

» [G] Display

Content Library

Z Rotate

ol Settings

Show Sub tems
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Go into your parameters for the Cube object. Since we desire the Cube to go
straight up, we don't want any variation in our X Translate. So set that to 0.00.

cube [Enter text to filter by...

All X Translate o O @D &

Favorites
Ay

Currently Used N

-r F?d‘ P T

To test if it's working, let's look at Frame 3 again.

53
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The Ghost Movement has stopped on the left side of Frame 5. Now the X
Translate is 0.00 on our Frame 3 which previously had a positive value.

‘-.. Default Camera L 9 2
v cube

All

Favorites

Currently Used
v @ cube

v [G] General

[G] Translation
@ Rotation

Parameters

Mesh Resol... [ X Rotate
» [G] Display

©
=
=
|
-
=
i
el
c
o
(&)

Z Rotate

Show Sub tems

ol Settings
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Let's look at Frame 7.

Frame 7 also has some Ghost Movement, it's higher than our Y Translate peek.
The highest Y Translate should be 130.84, but instead we have a value of 140.26.

54 Default Camera v .J' 2

cube

All

Favorites

*
+=4
-

o

Currently Used
v @ cube
¥ [G] General

F+'|
Ld

9

Parameters

Translation

X Rotate

Content Library

w
o
c

=

=
]
w
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Change the Y Translate value to the peek value, which in this case is 130.84.

v @ cube

v [G] General

¥ Translate of O EELECED £F

rameters

[G] Translation

Now we have keyframes on either side of Frame 5 that we are using to fix our
ghost movement problems. You can check this by going to Frame 8.

.-.. Default Camera v .J 2
W Bl cube

=

All

-
=9
-

Favorites

ol

Currently Used
v @ cube

v [G] General

r
+'|
(Ch]

o]

Parameters

X Rotate

Content Library

ol Settings
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When you play it, it should move up completely vertical, then to the left
completely horizontal.

O »  Ow Ow

f
1
.

If for some reason you make an animation and this does not fix your Ghost
Movement problems, try placing a few keyframes with the desired values in
between 2 keyframes where the problem occurs until it's solved.
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Chapter 5: Animating Multiple Objects

(@)
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It's time that we worked on animating multiple objects in our scene. Start with a
new scene and go ahead and use Create -> New Primitive... to create a Sphere

Fie Edit Create Toolz Render Connect Window

Actor B \evcrer g
*—= Mew Distant Light...

Mew Null...

New Group...

Mew Node Instance...

Mew Mode Instances...

MNew Geometry Shell...
0 Mew D-Former...

*_. Mew Push Modifier Weight Mode...

Origin :

Options ;

——
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In addition to that Sphere, let's add a Torus to the scene as well.

[

R A AAAANANAANANANANANNN N N NN———=——==—._jh—.
et

Origin

Options :

Major Diameter :
Minor Diameter :
Segments

Sides

60
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Adjust your view to face the Front.

‘-‘. Default Camera v !J'r

Scale the Sphere down to 65% to make it a bit smaller. This should be small
enough that it could easily fit through the Torus opening.
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Let's create a base keyframe for our Torus. Be sure to select the Torus in the
Scene tab. Now move the Torus upwards to where it is centered vertically on the
Sphere and create your keyframe at Frame 0.

Now go to Frame 15.

Using the Parameters tab, set the Z Rotate to 90.00. This will rotate the Torus.

Z Rotate 90,00
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Now that we rotated it, it is offset again...we need to fix that so that from Frame 0
to Frame 15 our Torus stays centered on the Sphere.

Move (retranslate) the Torus until once again the Sphere is in the very center.
Create your keyframe.
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Now go to Frame 30.

Change the Z Rotate to 180.00.

Z Rotate 150,00

One last time, we need to fix the Torus so that from Frame 15 to Frame 30 the
Torus still stays centered on the Sphere.
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Translate the Torus until it looks centered on the Sphere. Create your keyframe.

We now have an animation of a Torus spinning 180 degrees around the Sphere in
the center of our scene. Play your animation to see if it is functioning properly.

Even with those changes however, we may still have problems. Play and step
through the animation, if you spot a frame where the Torus looks offset go ahead
and select that frame.

For instance my Frame 20 looks offset to me.
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Go ahead and fix it then keep doing this until your Torus spins smoothly at the
very center around the Sphere.

Now select your Sphere.

You'll notice that the keyframes you had made have now disappeared from the
Timeline. This is because each object has it's own separate Timeline. So now we

are going to create a Timeline for our Sphere, since we created one already for the
Torus.

aniMate Lite Timeline ’E
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We need to set the base keyframe for our Sphere. Go to Frame 0.

Move the Sphere along the X-Axis a good amount. I chose 250.00.

X Translate 250.00

Now your Sphere is to the right of your Torus. Create your new keyframe.
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Now go to Frame 15.

At the middle of our animation we want the Sphere to be in the center of the
Torus, so at Frame 15 we set the X Translate of our Sphere to 0.00. This isn't a
crucial step, but for such animations where two objects are working together to
create an animation, you may need to add these extra keyframes when an object
needs to be at a specific location in a specific frame of the timeline.

X Translate
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Create your keyframe.

Now go to Frame 30.

We want the Sphere to be on the opposite side of the Torus at the end of the
animation, so we set the value at Frame 30 to be -250.00.

X Translate -250.00
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Now the animation is completed, and ready to be watched with the Play button.

This is the animation. The Sphere comes from the right side, moves through the
Torus, and exits the Torus towards the left.
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Obect (ollision

In the previous example, there should not be any collisions. However, if the Torus
instead only spun 90 degrees as the Sphere was near it, then the Sphere would
possibly collide into it like seen below.

To fix collisions like this without having to rethink your object sizes or speeds just
find the frame where the collision occurs. Now move the object out of the
collision, but still on course. In the case below, I pulled the sphere backwards out
of the collision. Now the Sphere will move through the Torus as it spins open at
180 degrees. You may also consider deleting keyframes that already exist which
may be causing a speed increase/decrease of your object due to this change.
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Parenting

It's now time to talk about another interaction between two objects...Parenting.

Be sure to return your animation to the beginning with the Skip To Start button.
Now select your Torus object in the Scene tab.

Enter text to filter by..

&8« Defautt Camera

H. Default Camera

Remove tem from Scene

Select

Parameters

Expand

Collapse
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Select 'sphere' and click 'Accept'.

Select a new parent for “torus”.

ﬂ.. Default Camera

None

Parent in place
Show Hidden Nodes

B os - = 2 7

The 'torus' will now show-up indented underneath 'sphere’, signifying 'sphere' is
it's Parent in the scene hierarchy

|Enter textto fiter by

oy By @« Default Camera

oy R T@spher&
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Initially, once we change the Parent of Torus, nothing will seem to happen.
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That's only because we had previous keyframes added to Torus. If we Clear
Animation for Torus using Edit / Figure or Edit / Object on the main menu...

Enter text to filter by...

dty K @ Default Camera
ay R T@sphere

Consolidate Properties

Show Hidden Properties
ersistent Group Expansion

Dizplay Separate tems

Dizplay Followers

Copy

Paste

KMemorize

Restore

Clear Figure
Clear Figure Pose
Clear Figure Shape
Symmetry... Shift+y
Bake To Transforms... Shift+B
Move To Floor Ctri+D
Transfer Active Morphs
Edit Mode
Make Pane Undockable
Make Pane Group Undockable

Close Pane
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...the Torus will snap to Sphere's base.

Be sure to select the Sphere in the Scene tab. If we move to a different frame,
such as Frame 15...

...you'll see the Torus (which does not have any keyframes) follows the Sphere.
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Let's make the Torus spin, but this time spin around the Sphere. Go to Frame 0.

Select the Torus in the Scene tab. Resize the Torus and move it to the center on
the Sphere. Create your new keyframe.
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Go to Frame 30.

Set the Z Rotate to 180.00.

Z Rotate 180.00

Once again, center the Torus. vertically on the Sphere. Create your keyframe.
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Go to Frame 15.

Our Frame 15 is offset.

So one more time, center the Torus and create your keyframe.
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If there are any frames where the Torus seems offset, go ahead and fix them.

Now when you play the animation you should see the Sphere going from right to
left, the Torus sticking with the Sphere, and the Torus spinning around the
Sphere as they both move
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The last thing I want to show in our basics of animation is how to animate a figure.

Find a figure to work on, I chose Genesis.

@ Wy Library

A AT, - TS
Enter text to search by...

ﬁ-‘g Poser Formats

& Other Import Formats
13

g’ Products

[ ;
=i! Categories

Scene

F Y

- r—
1-1 of 1

Actor

-

{2

Parameters

)
=
=
2
=
g
e

Content Library
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We are going to have this figure make an exaggerated wave.

&« Default Camera

First off, we are going to be needing more than the default amount of frames. Set
the total frames to 61 by clicking in the Total field and typing 61.
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Select the Right Shoulder of your figure in the Viewport or by using expanding
the figure in the Scene tab and selecting Right Shoulder there.
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If you look at the Posing tab, you'll see a variety of controls to change the position
of your figure's body parts.

«.Right Shoulder | v

All

Favorites

Currently Used
¥/ Right Shoulder

» [G] Transforms

Show Sub tems
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We want to bend the Right Shoulder to maximum value bringing it down by the
side of the Genesis figure.

756,00

Select the Left Shoulder and do the same, but for this one use the minimum value
to bring it down by the side.

Now that the figure has both arms down at the sides, set Frame 0 as a keyframe.
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Go to Frame 30.

Set the Right Shoulder to bend it's max the other direction.

It should look something similar to this.
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Now select the Right Collar.

Bend the Right Collar to its minimum bringing it towards the neck.

-40.,0:0
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It may look silly at the moment, but that will change.

Once again select the Right Shoulder. This time Twist it to the limits in the
direction where the palm is facing towards you.
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Now it's starting to look more like a waving position.
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Now select the Right Forearm.

Go to Frame 25.

Create a keyframe here. This will give us a base keyframe for our forearm.
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Go to Frame 40.

Now bend the Right Forearm somewhat, towards the figure's head. This will be a
part of the actual waving motion.
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Go to Frame 50.

Set the Right Forearm to bend back to where the forearm is straight with the rest
of the arm. This will be the end of the actual waving motion.

-20.00
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Select the Right Shoulder again.
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Go to Frame 40.

Go to Frame 60.

Bend the Right Shoulder back down somewhat, towards the body.

10,00
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The idea here is to have the Right Shoulder start to head back down a bit once the
forearm has finished it's wave.

You can test our animation progress so far with the Play/Pause button. Once you
are satisfied, be sure to use the Skip To Start button to rewind to beginning.
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Now let's get the torso to move a little bit, so our figure is less stiff in the
animation. Select the Abdomen.

Create a base keyframe at Frame 0.
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Go to Frame 25.

Create a base keyframe here too, since this is where the torso will actually start to
move.

Go to Frame 40.

Make the Abdomen move with the wave by moving it Side-Side.

Side-5ide

A
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Now at the end of the first waving motion, the torso moves with the arm.

Go to Frame 60. We need to set the Abdomen back to its default position so it
moves back to normal as the wave completes.

Side-5ide
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Now select the Head.
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Go to Frame 25.

Create a base keyframe here.

Go to Frame 40.

Move the head Side-Side somewhat in the motion of the wave. Even slight
movements that aren't directly noticeable can create subtle impacts to your
animation. So the more you want it noticed, make the value higher. I just barely
moved it in this case since it isn't as important.

Side-5ide
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Now the head tilts with the wave.
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Go to Frame 60 and set the Head back to it's default position for the end of the
wave.

Side-5Side

Now as the wave finishes, the Head goes back to normal.
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This example shows the interaction between objects and their Timelines. Realize
that a lot of the objects we moved were parented to other's, which made it so we
didn't have to move things like the hand, since it moved with the shoulder and
forearm. Also look at Frame 30. At this frame we set the Right Shoulder to stop
its motion. At this time we wanted our forearm to start it's waving motion. BUT,
instead of starting the forearm motion at Frame 30, we started the motion at
Frame 25. This is because in the beginning of an animation of an object, it has a
slow startup, so to make it more fluid we start it earlier. Like in this example,
animate each object separately through the animation a step and frame at a time.
This will not only make it easier on yourself, but create a much more fluid
animation since you will be making decisions based on other object's current
positions.

With that, you should have a decent start to an exaggerated waving animation.
Obviously there are some things that can be modified such as the fingers being
straight and maybe even facial expressions, but that's for you to decide...
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E 3 g ! L
You have now learned much of the basics of animating in DAZ Studio, you should
be able to take what I showed here from the technical to the various practicing. It's
time you started animating your own objects and create something fun. The

waving animation we made wasn't just for an example, but to wave goodbye to you
and wish you GOOD LUCK!

Good-Bye (for now)
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